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1	 Introduction

In 2012, Bio-Rad’s PrimePCR Assays set a new standard for real-time PCR gene 
expression analysis. We collaborated with leaders in real-time PCR to design, optimize, and 
experimentally validate PCR primers for mRNA gene expression assays across the human, 
mouse, and rat transcriptomes. Products are available as individual SYBR® Green Assays, 
individual probe assays, pathway and disease arrays, and custom-configured plates. 
Reference gene and experimental control assays are also available. Assays are validated for 
use with Bio-Rad’s amplification reagents. All PrimePCR Assays and Arrays can be ordered 
online at bio-rad.com/PrimePCR. 

PrimePCR Assays, Arrays, and Controls 

SYBR® Green Assays
Transcriptome-wide assays are available for gene expression analysis. Individual assays are 
provided as a 20x stock solution of 200, 1,000, or 2,500 x 20 µl reactions. Each PrimePCR 
Assay provides a Unique Assay ID, which can be easily tracked and reported in publications. 

Probe Assays
5' exonuclease probe assays are available for gene expression analysis. Each assay can 
be labeled with a FAM, HEX, TEX 615, Cy5, or Cy5.5 fluorophore. Individual assays are 
provided as a 20x stock solution in 200 (FAM only), 500, 1,000, or 2,500 reactions. Each 
PrimePCR Assay provides a Unique Assay ID, which can be easily tracked and reported  
in publications. 

Predesigned Pathway and Disease Arrays
A wide range of pathway- or disease-specific gene arrays are available in 96- or 384-well 
plates. Primer pairs are lyophilized in the wells on the plate. Plates are designed for use with 
SYBR® Green detection chemistry and include experimental controls and reference assays. 
Plates are available for all major real-time PCR instruments (see the list of compatible real-
time instruments under Reagents and Equipment).

http://bio-rad.com/PrimePCR
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Custom Plates
96- and 384-well PCR plates can be user designed with PrimePCR SYBR® Green Assays. 
Custom primer assays can also be added. Primer pairs are lyophilized in the wells on the 
plate. Plates are available for all major real-time PCR instruments, and can be designed with 
or without experimental controls.

PreAmp Assays
Individual PrimePCR PreAmp Assays are available for unbiased preamplification of target 
genes from small quantities of cDNA. Each assay is provided as a 100x stock solution and 
corresponds to a SYBR® Green or probe gene expression assay. 

PreAmp Assay Pools
Preblended PrimePCR lncRNA PreAmp Assay Pools are available for use with PrimePCR 
lncRNA Predesigned Arrays. Each assay within the pool is provided as a 100x stock solution 
and corresponds to the SYBR® Green lncRNA Gene Expression Assay included on the 
corresponding array.

DNA Templates
Assay-specific synthetic DNA templates are designed to give a positive PCR result when 
used with the corresponding SYBR® Green or probe assay. Templates are provided as a 20x 
stock solution of 200 reactions.

Experimental Control Assays
Experimental control assays are available for RNA quality assessment, genomic DNA 
contamination, reverse transcription (RT), PCR performance, and preamplification 
assessment. Controls can be ordered as individual assays or preplated on predesigned or 
custom PCR plates.

Reference Gene Assays
Commonly used reference gene assays are available to normalize for variation in the amount 
of input RNA among samples. Assays can be ordered as individual assays or added to a 
custom plate. Predesigned reference gene arrays are available in 96- and 384-well plates.

Shipping and Storage
PrimePCR Assays and Plates are shipped at room temperature. Upon receipt, store product 
at 4°C (up to 12 months). For long-term storage, store at –20°C. 

Preblended PrimePCR lncRNA PreAmp Assay Pools can be stored at 4ºC for up to 
1 month. For long-term storage, store at –20ºC.

If storing assay at –20°C, prevent oligonucleotide degradation by aliquoting the total volume 
into smaller volumes to minimize the number of freeze-thaw cycles. 

cDNA synthesis kits and supermixes are shipped on dry ice and should be stored at –20°C. 
Refer to individual product manuals for more details.
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Reagents and Equipment 

Consumables and Equipment Needed for Gene Expression Analysis
■■ cDNA synthesis kit 

■■ Centrifuge

■■ Gene expression analysis software

■■ Microcentrifuge tubes

■■ Nuclease-free pipet tips and tubes

■■ Nuclease-free water

■■ Optical seals

■■ PCR plates or strips (if not using a preplated array)

■■ Pipets — single channel and multichannel

■■ Purified RNA samples

■■ Real-time PCR detection system 

■■ SYBR® Green or probe supermix 

■■ TE buffer (pH 7.5, nuclease-free) — use for dilution of reverse transcription control template 

■■ TE buffer with 10 ng/ml transfer RNA (tRNA; pH 8.0, nuclease-free) — use for standard 
curve dilutions

Guaranteed Performance
PrimePCR Assays are guaranteed to perform with the following quantitative PCR (qPCR) reagents:

■■ iScript Advanced cDNA Synthesis Kit for RT-qPCR*

■■ iScript cDNA Synthesis Kit

■■ iScript Reverse Transcription Supermix for RT-qPCR

■■ iScript gDNA Clear cDNA Synthesis Kit

■■ iScript Explore One-Step RT and PreAmp Kit

■■ SsoAdvanced PreAmp Supermix 

■■ SsoAdvanced Universal Probes Supermix 

■■ SsoAdvanced Universal SYBR® Green Supermix 

■■ iTaq Universal Probes Supermix

■■ iTaq Universal SYBR® Green Supermix

* Reagent used for validation report.
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Compatible Real-Time PCR Instruments
PrimePCR Assays and Arrays are available for the following real-time PCR detection systems:

Bio-Rad

CFX96, CFX384, CFX96 Touch, CFX384 Touch, CFX Connect, Chromo4, iQ, iQ5, MyiQ, 
MyiQ2, Opticon, Opticon2

Applied Biosystems 

7300, 7500 (standard and Fast), 7900 (standard and Fast, 96- and 384-well), ViiA 7 
(standard and Fast, 96- and 384-well), QuantStudio (standard and Fast, 96- and 384-well), 
StepOnePlus

Stratagene Mx

Eppendorf realplex

Roche 

LightCycler 480 (96- and 384-well), LightCycler 96

Important:  Verify instrument and fluorophore compatibility.

Note: Additional real-time PCR instruments may be compatible with PrimePCR Assays and 
Arrays. Verify instrument and fluorophore compatibility.

Tips for Success
For a complete description of how to optimize a gene expression experiment, please visit 
the gene expression workflow section of our Applications and Technologies pages at  
bio-rad.com/en-us/applications-technologies/real-time-pcr-experimental-design.

Ensure High RNA Quality and Quantity
To obtain optimal real-time PCR results, start with high-quality RNA from all samples. 
RNases, salts, proteins, and other contaminants can compromise the integrity of RNA 
samples and may impact the performance of downstream enzymes used in reverse 
transcription and PCR reactions.

■■ Decontaminate the workspace of RNase, salt, and protein sources

■■ Limit the number of freeze-thaw cycles of RNA sample, ideally to 1 cycle

■■ Use screw-cap tubes for long-term RNA storage at –80°C

■■ Use nuclease-free plastics and solutions

■■ Determine concentration and purity of RNA prior to gene expression experiment

■■ Mass normalize RNA samples by dilution with nuclease-free water prior to the reverse 
transcription reaction

Introduction

http://www.bio-rad.com/en-us/applications-technologies/real-time-pcr-experimental-design
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Prevent and Monitor Genomic DNA Contamination
Genomic DNA (gDNA) present in real-time PCR experiments can cause inaccurate gene 
expression quantification. Although PrimePCR Assays were designed for intron-spanning 
regions when possible, elimination of gDNA contamination is a best practice for high-quality 
qPCR results.

■■ Perform a DNA digestion step with DNase during RNA purification

■■ Include a gDNA experimental control to determine if gDNA is present (see DNA 
Contamination Control Assay in Step 3 of Chapter 2, Gene Expression Protocols)

Select Appropriate Reference Genes
Choosing an appropriate reference gene(s) to normalize for variation in the amount of input 
RNA among samples is important for accurate gene expression analysis. Consult Chapter 6, 
Reference Gene Selection and Reference Gene Arrays, to learn how to determine a stably 
expressed gene target for your samples of interest.

Calibrate the Real-Time PCR Instrument for Dyes and Fluorophores 
Prior to starting a qPCR experiment, verify that the real-time PCR instrument is compatible 
and calibrated correctly for the dyes and fluorophores chosen. CFX Manager and  
CFX Maestro Software have a Dye Calibration Wizard with an easy guide to calibration 
(Tools > Dye Calibration Wizard). Bio-Rad’s CFX instruments are calibrated with pure dyes 
to correspond to PrimePCR fluorophore options before installation. Refer to the instrument 
manual to determine calibration settings, and calibrate accordingly if necessary.

Fluorophore/Dye Excitation, nm Emission, nm

SYBR® Green 494 521

5' FAM 495 520

5' HEX 538 555

5' TEX 615 596 613

5' Cy5 648 668

5' Cy5.5 685 706

Use Optical PCR Plate Seals
Use optical seals for accuracy when collecting real-time PCR data. Adhesive seals and heat 
seals are available options. Bio-Rad recommends using the PX1 PCR Plate Sealer with 
optical heat seals for consistently sealed PCR plates. Seals must fully enclose the PCR plate 
to prevent evaporation from the wells during thermal cycling. Evaporation is identified by 
analyzing technical repeats of data — specifically, if a well near the edge of the plate yields 
variable data, evaporation has likely occurred.

Introduction
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Determine the Threshold Setting
Determining placement of the threshold line is important for accurate quantification of gene 
expression levels. For precise comparisons of gene expression levels between samples, 
determine quantification cycle (Cq) values for a gene only when the threshold line has been 
defined uniformly for all samples being analyzed. While the threshold can be set manually 
or automatically using the instrument’s software, it is important that the same numerical 
threshold value be used across all samples, whether they are on the same or multiple 
plates. The threshold is typically placed at least ten standard deviations above the average 
baseline fluorescence level where the PCR reaction is undergoing exponential amplification. 
As an example, 300 rfu was used as the uniform threshold line setting for all PrimePCR 
assay validation experiments on a CFX384 instrument.

Multiplex Assay Considerations
PrimePCR Probe Assays have been optimized to work under the same thermal cycler 
conditions, allowing for multiple assays to be used in the same well with different 
fluorophores. To ensure data generated in a multiplex reaction are equivalent to data 
generated in a singleplex reaction, it is imperative to evaluate the assay performance in  
both multiplex and singleplex reactions. It is also important to understand the expression 
level of your target sequences, as this will impact the multiplex optimization method. 
Consult the SsoAdvanced Universal Probes Supermix Instruction Manual for more details 
on multiplexing. 

Below is a brief list of considerations when conducting multiplex reactions:

■■ Determine expression levels of gene targets

■■ Use brighter fluorophores for lower-expressing targets

■■ Compare standard curve of singleplex reaction to multiplex reaction

■■ Efficiency of multiplex reaction must be similar to minimize amplification bias

■■ Target abundance should not vary greatly between multiplex assays

Introduction
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2	 Gene Expression Protocols

This chapter provides protocols for RNA isolation, cDNA synthesis, real-time PCR reaction 
setup (in each PrimePCR format), and the real-time PCR instrument run. Please follow the 
appropriate protocol for the format of your experiment (individual assays, 96- or 384-well 
plates). Remember to set up controls alongside reverse transcription and PCR reactions.

Overview: Real-Time PCR Workflow
Step 1: Isolate RNA
■■ Aurum Total RNA Mini Kit

■■ Aurum Total RNA Fatty and Fibrous Tissue Kit

Step 2: cDNA Synthesis and Optional Preamplification
■■ iScript family of reverse transcription reagents

■■ Optional: Prepare preamplification reaction

−− PrimePCR PreAmp Assays

−− iScript Explore One-Step RT and PreAmp Kit

−− SsoAdvanced PreAmp Supermix

Step 3: Prepare Real-Time PCR Reaction
■■ PrimePCR Assays and Arrays 

■■ SsoAdvanced Universal Supermixes

Step 4: Cycle in Real-Time PCR Instrument
■■ CFX Real-Time PCR Detection Systems

Step 5: Analyze Gene Expression Data
■■ CFX Manager or CFX Maestro Software

■■ PrimePCR Analysis Software
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Gene Expression Protocols

Step 1: Isolate RNA
1.	 Isolate and purify the RNA sample(s) using Aurum Isolation Kits or a similar product.  

The Aurum Total RNA Mini Kit (catalog #7326820) and the Aurum Total RNA Fatty and 
Fibrous Tissue Kit (catalog #7326830) enable RNA isolation from a wide range of cells 
and tissues and include a DNase digestion step to ensure DNA-free total RNA. Refer to 
the instruction manual for the detailed protocol.

2.	 Analyze the RNA sample for integrity and purity. 

a.	 Use Bio-Rad’s Experion Automated Electrophoresis System, the Agilent Bioanalyzer, 
or similar system to evaluate the integrity of the RNA sample. For gene expression 
analysis, ensure that the RNA quality indicator (RQI) or RNA integrity number (RIN) 
values are similar between samples to yield accurate qPCR results. An RQI value of 
10 indicates intact RNA, whereas a value of 1 indicates degraded RNA.

b.	 Use an agarose gel to assess RNA integrity if the above systems are not available. 
High-quality eukaryotic RNA yields two clean peaks, 18S and 28S. Degraded RNA 
appears as a smear on the gel. 

c.	 To assess purity, evaluate the following spectrophotometer readings:

A260/A280 > 2.0 for pure RNA (assesses DNA contamination)

A260/A230 ~2.0 for pure RNA (assesses protein contamination)

Lower ratios indicate the presence of contaminants such as salts, carbohydrates, 
peptides, proteins, phenols, and guanidine thiocyanate.

3.	 Assess total RNA concentration using a SmartSpec Plus Spectrophotometer or  
similar instrument.

4.	 Normalize RNA concentration across samples by diluting in nuclease-free water.

5.	 Store RNA sample(s) at –80°C in single-use aliquots and at equivalent concentrations.

Step 2: cDNA Synthesis and Optional Preamplification

cDNA Synthesis
Use the iScript family of reverse transcription reagents for cDNA synthesis. The iScript 
Advanced cDNA Synthesis Kit for RT-qPCR was used during wet-lab validation of 
PrimePCR Assays. In a single 20 µl reaction, this two-tube kit provides increased data 
throughput and the widest possible linear dynamic range through its loading capacity of up 
to 7.5 µg total RNA.

Note: If using iScript Explore One-Step RT and PreAmp Kit, omit this separate cDNA 
synthesis step and proceed to the Prepare cDNA Synthesis and Preamplification Reaction 
Using the iScript Explore Kit section on page 10.

1.	 Thaw kit contents and normalized RNA samples on ice. Mix components thoroughly, 
centrifuge briefly to collect solutions at the bottoms of tubes, and then store on ice.

2.	 Use the same amount of RNA in each cDNA synthesis reaction. Typically 1–5 µg total 
RNA is sufficient, but may be adjusted depending on abundance of target transcript.



PrimePCR Assays, Arrays, and Controls for Real-Time PCR  |  9

Reagents Description

5x iScript Advanced Reaction Mix (red cap) 5x reaction mix with dNTPs, oligo(dT), random primers, buffer, 
MgCl2, enhancers, and stabilizers

iScript Advanced Reverse Transcriptase 
(orange cap)

RNase H+ Moloney murine leukemia virus (MMLV) RT enzyme 
and RNase inhibitors

Nuclease-Free Water

3.	 For each RNA sample, prepare a cDNA synthesis reaction on ice.

4.	 If using the PrimePCR RT Control Assay, dilute the lyophilized RT control assay template 
in 200 µl nuclease-free TE buffer (pH 7.5) or the same reagent used to dilute RNA 
samples. Keep the template on ice. It will degrade similar to RNA samples if exposed 
to multiple freeze-thaw cycles, ambient temperatures, or RNases. When preparing the 
cDNA synthesis reaction, add 1 µl of the diluted RT control template.

Component Volume per Reaction

5x iScript Advanced Reaction Mix 4 μl

iScript Advanced Reverse Transcriptase 1 μl

RNA (100 fg to 7.5 µg)* Variable

RT Control Assay Template 1 μl

Nuclease-Free Water Variable

Total volume 20 μl

* It may be necessary to optimize the amount of input RNA due to differences in target gene 
expression levels and sample availability. See Step 6 for an example calculation. 

5.	 Incubate the complete reaction mix in a thermal cycler according to the table below:

Step Temperature, °C Time Duration, min

Reverse transcription 46 20

RT inactivation 95 1

Note: An alternative protocol (30 min at 42ºC and 5 min at 85ºC) can be used if needed. 
Both protocols yield equivalent cDNA results.

6.	 Dilute the cDNA reaction to the desired volume for qPCR reactions. The ideal range of 
input cDNA per qPCR reaction is 1–25 ng. Altering the amount of input RNA or the level of 
cDNA dilution can optimize gene expression results for a given collection of genes. Below 
is a step-by-step example calculation from starting input RNA through amount of cDNA 
per qPCR reaction used for a PrimePCR 96-well array with 96 unique gene targets:

1 µg input RNA per 20 µl RT reaction = 50 ng/µl

Dilute cDNA to 100 µl = 10 ng/µl

Use 1 µl diluted cDNA per 20 µl qPCR reaction = 10 ng cDNA per reaction

Gene Expression Protocols
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Prepare and Run Preamplification Reaction (optional)

Preamplification Overview
Preamplification Reagents
For the unbiased amplification of small qualities of cDNA, use preamplification prior to 
preparing the real-time PCR reaction. Two different methods for cDNA synthesis and 
preamplification are described below. Be sure to follow the protocol that corresponds to the 
preamplification reagents being used. 

Method Products Description Key Benefits

One-step n �iScript Explore Kit cDNA synthesis and  
preamplification done in a  
single step
n �RNA is used as input sample
n �Reverse transcription done using 

gene-specific priming 

n �Protocol minimizes  
hands-on time

n �Kit integrates an effective  
DNase digestion step 

Two-step n ��iScript Family 
of Reverse 
Transcription 
Reagents

n �SsoAdvanced  
PreAmp Supermix

cDNA synthesis and 
preamplification performed in 
separate steps
n �Perform cDNA synthesis using 

any of the iScript family of reverse 
transcription reagents

n �cDNA is used as input sample  
for preamplification reaction

n �Flexibility with cDNA synthesis 
method of choice

n �SsoAdvanced PreAmp  
Supermix is a single-tube,  
ready-to-use reaction  
master mix that simplifies  
reaction setup

Prepare cDNA Synthesis and Preamplification Reaction Using the iScript Explore Kit
1.	 Prepare for cDNA synthesis and preamplification procedure using the iScript 

Explore Kit.

a.	 Prepare preamplification assay pool with PrimePCR PreAmp Assays.

Note: Bio-Rad offers preblended PrimePCR lncRNA PreAmp Assay Pools for all 
PrimePCR lncRNA Predesigned Arrays. If using these preblended pools, this step 
can be skipped. 

i)	 Add 5 µl of each PrimePCR PreAmp Assay (up to 100 assays) to a 
microcentrifuge tube.

ii)	 Bring total volume of assay pool up to 500 µl with nuclease-free water.

iii)	 Mix thoroughly, briefly centrifuge, and store on ice.

iv)	 Use 5 µl of the assay pool in a 50 µl reaction with the iScript Explore Kit.

b.	 Thaw iScript Explore Kit components on ice. 

c.	 (Optional) Prepare the PrimePCR RT Control Assay Template.

i)	 If running the PrimePCR RT Control Assay, resuspend the lyophilized template 
in 200 µl nuclease-free TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0). Keep 
template on ice, as this template is RNA and will degrade similar to RNA samples 
if exposed to multiple freeze-thaw cycles, ambient temperatures, or RNases.

Gene Expression Protocols
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2.	 Prepare genomic DNA clearance reaction.

Note: The gDNA clearance reaction is recommended, but may be omitted in procedure 
if desired. Adjust reaction volumes accordingly by adding equivalent volume of water to 
reaction in one-step reverse transcription and preamplification reaction.

a.	 Prepare the DNase reaction mix by combining only the DNase enzyme and DNase 
buffer according to the guidelines in the table below. If multiple reactions are required, 
scale up appropriately. Mix thoroughly by pipetting up and down several times.

Component Volume per Reaction, µl

iScript DNase I (blue cap) 0.5

iScript DNase Buffer (yellow cap) 1.5

Total volume 2

b.	 Dilute RNA samples with nuclease-free water such that the final input RNA is 
equivalent between samples, up to 1 µg of input RNA. Refer to table below for  
input volumes.

c.	 In a new tube, prepare the gDNA clearance reaction according to this table. 
Important! If using the optional PrimePCR RT Control Assay (included with all 
PrimePCR Arrays and Assays) in the downstream qPCR reactions, the RNA template 
must be added at this step.

Component
Volumes If Using  

PrimePCR RT Control, µl
Volumes If Not Using  

PrimePCR RT Control, µl

RNA Sample 10.5 11.5

DNase Reaction Mix 1.5 1.5

PrimePCR RT Control Template 1

Total volume 13 13

d.	 Pipet solution up and down to mix well. Pulse centrifuge to collect the contents in the 
bottom of tube.

e.	 Using a thermal cycler with heated lid, incubate the reaction tubes according to the 
guidelines in the following table.

Steps Temperature, °C Time Duration

DNA digestion 25 5 min

DNase inactivation 75 5 min

Storage conditions 4, on ice Until reverse transcription and 
preamplification reaction

Note: To avoid degradation of RNA, we recommend proceeding directly to the one-step 
reverse transcription and preamplification reaction. However, if longer storage is necessary, 
samples can be stored at –20°C and thawed on ice when proceeding to the one-step 
reverse transcription and preamplification reaction.

Gene Expression Protocols
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3.	 Prepare the one-step reverse transcription and preamplification reaction.

a.	 Prepare the one-step reverse transcription and preamplification reaction mix according 
to table below and mix well. Reactions should be assembled on ice. If multiple 
reactions are required, scale up appropriately.

Component Volume per Reaction, µl

SsoAdvanced PreAmp Supermix (2x) (purple cap) 25

PreAmp Assay Pool 5

Nuclease-Free Water (clear cap) 5

iScript Advanced Reverse Transcriptase (orange cap) 1

iScript Explore Reaction Booster (red cap) 1

Total volume 37

Note: The volumes in the table above represent the precise amount required. We 
recommend preparing 10% excess to account for pipetting error. 

b.	 Add 37 µl of the one-step reverse transcription and preamplification reaction mix to 
each PCR tube containing 13 µl of DNase-treated RNA sample for a total reaction 
volume of 50 µl.

c.	 Pipet up and down to mix well. Pulse centrifuge to collect the contents in the bottom 
of tube.

d.	 Program the thermal cycling protocol on a PCR instrument according to the table 
below. We suggest running 14 cycles of preamplification as a starting point for target 
enrichment, however, the number of preamplification cycles may be adjusted from  
10 cycles up to 16 cycles.

Step Temperature, °C Time Cycles

Priming 25 5 min 1

Reverse transcription 45 60 min 1

RT inactivation 95 3 min 1

Preamplification
95 15 sec

14 cycles total
58 4 min

Hold 4 ∞

e.	 Load the samples into PCR instrument and start the reaction program.

f.	 After run completion, the preamplified cDNA can be stored at –20°C for up to 12 
months or at 4°C for up to 72 hours. 

4.	 Dilute sample and prepare for real-time PCR reactions.

a.	 Dilute the preamplified cDNA sample to a minimum of 1:10 with TE buffer. 

Note: A larger dilution may be required depending on the number of downstream 
qPCR reactions required. For example, a 1:50 dilution will provide enough volume for 
400 qPCR reactions using 2 µl of input with technical triplicates.
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b.	 For optimal results, use 2 µl of the diluted reaction products per 20 µl qPCR reaction 
or 1 µl per 10 µl qPCR reaction for a 96-well or 384-well plate, respectively. We 
recommend using SsoAdvanced Universal SYBR® Green Supermix or SsoAdvanced 
Universal Probes Supermix as the qPCR master mix, depending on the detection 
chemistry of the assays used.

Prepare Preamplification Reaction Using SsoAdvanced PreAmp Supermix
1.	 Prepare preamplification assay pool with PrimePCR PreAmp Assays. 

Note: Bio-Rad offers preblended PrimePCR lncRNA PreAmp Assay pools for all PrimePCR 
lncRNA Predesigned Arrays. If using these preblended pools, this step can be skipped.

a.	 Add 5 µl of each individual PreAmp Assay (up to 100 assays) to a microcentrifuge tube.

b.	 Bring total volume of assay pool up to 500 µl with nuclease-free water.

c.	 Mix thoroughly, briefly centrifuge, and store on ice.

d.	 Use 5 µl of the assay pool in a 50 µl SsoAdvanced PreAmp reaction.

Note: Assay pools are stable at 4°C for up to 30 days and at –20°C for up to 1 year. 

2.	 Thaw SsoAdvanced PreAmp Supermix and cDNA samples. Mix thoroughly by inversion 
or by a 15 sec vortex. Centrifuge briefly to collect solutions at the bottom of each tube 
and then store on ice and protected from light.

3.	 Prepare preamplification reaction mix on ice. Good pipetting practice must be employed 
to ensure assay precision and accuracy.

Component Volume per Reaction Final Concentration

2x SsoAdvanced PreAmp Supermix 25 μl 1x

PrimePCR PreAmp Pool 5 μl 1x

cDNA Sample Variable 250 ng–100 pg

Nuclease-Free Water Variable —

Total volume 50 μl —

4.	 Mix the reaction mix thoroughly to ensure homogeneity and dispense into a PCR tube or 
into the wells of a PCR plate.

5.	 Load the PCR tubes or plate into a thermal cycler and start the PCR run with the 
following thermal cycling protocol.

Step Temperature, ºC Time Number of Cycles

Activation 95 3 min 1

Denaturation 95 15 sec 10–12

Annealing/extension 58 4 min 10–12

Hold 4 ∞ 1

6.	 After run completion, the preamplification reaction can be stored at –20°C for up to  
12 months or at 4°C for up to 72 hr.

Gene Expression Protocols
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7.	 The completed preamplification reaction should be diluted to a minimum of 1:5 with  
TE buffer. However, a larger dilution volume may be required, depending on the number 
of assays planned for downstream qPCR and the number of technical replicates. 
For example, a 1:15 dilution will provide enough volume for 100 qPCR assays using 
technical triplicates and 2 µl per reaction.

100 qPCR assays in triplicate = 100 assays x 3 replicates x 2 µl = 600 µl needed

1:15 preamplification reaction dilution = 750 µl

150 µl excess

8.	 Use 2 µl of the dilution per 20 µl qPCR reaction or 1 µl per 10 µl qPCR reaction for a 
96- or a 384-well plate, respectively.

Note: When using SsoAdvanced Universal SYBR® Green Supermix for qPCR after 
preamplification, run the activation and denaturation steps at 98°C if delayed Cq values or 
decreased efficiency occur.

Step 3: Prepare Real-Time PCR Reaction
Protocols for preparing real-time PCR reaction mix are described according to format  
(96-well plates, 384-well plates, or individual assays). Protocols for PrimePCR Control 
Assays are incorporated into the reaction setup. Please refer to Chapter 3 for interpretation 
of experimental control assays.

Pathway/Disease Array or Custom Plate — 96-Well Format
Primers are lyophilized in each well; therefore, add all remaining components to the PCR 
reaction mix.

1.	 Thaw SsoAdvanced Universal SYBR® Green Supermix, cDNA samples, and positive 
PCR control DNA template (if a PCR control assay is on the plate). Mix thoroughly by 
inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of 
tubes, and then store on ice and protected from light.

2.	 Allow the PrimePCR plate to come to room temperature prior to removing the seal.

3.	 Dilute each cDNA sample to a total volume of 100 µl if preparing a 96-well plate with 
unique targets.

4.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions  
by adding all required components. Scale up proportionally for multiple reactions.  
CFX Software has an easy-to-use master mix calculator that provides easy scale-up 
calculations for your experiment.
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Component Volume per Reaction Final Concentration

20x PrimePCR Assay Dried in well 1x

2x SsoAdvanced Universal SYBR®  
Green Supermix

10 μl 1x

cDNA Sample 1–4 μl* 100 ng–100 fg*

Nuclease-Free Water Variable —

Total volume 20 μl —

*	Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume (4 µl)  
of cDNA sample to avoid excessive carryover of PCR inhibitors.

5.	 Transfer 20 µl of the PCR reaction mix into each well. 

6.	 Optional: Add 1 µl PCR control assay template into the appropriate well (total volume 
will be 21 µl — additional volume will not affect the qPCR reaction).

7.	 Seal the plate with an optical seal. Optional: Briefly centrifuge to remove bubbles (4,000 rpm 
for 2 min at room temperature).

8.	 Load the PCR plate into the real-time PCR instrument.

Pathway/Disease Array or Custom Plate — 384-Well Format
Primers are lyophilized in each well; therefore, add all remaining components to the PCR 
reaction mix.

1.	 Thaw SsoAdvanced Universal SYBR® Green Supermix, cDNA samples, and positive 
PCR control DNA template (if a PCR control assay is on the plate). Mix thoroughly by 
inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of 
tubes, and then store on ice and protected from light.

2.	 Allow the PrimePCR Plate to come to room temperature prior to removing the seal.

3.	 Dilute each cDNA sample to a total volume of 400 µl if preparing a 384-well plate with 
unique targets.

4.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions by 
adding all required components. Scale up proportionally for multiple reactions.  
CFX Software has an easy-to-use master mix calculator that provides easy scale-up 
calculations for your experiment.

Component Volume per Reaction Final Concentration

20x PrimePCR Assay Dried in well 1x

2x SsoAdvanced Universal SYBR®  
Green Supermix

5 μl 1x

cDNA Sample 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable —

Total volume 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume (2 μl)  
of cDNA sample to avoid excessive carryover of PCR inhibitors.
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5.	 Transfer 10 µl of the PCR reaction mix into each well. 

	 Note: Be careful to not introduce bubbles during pipetting steps, since it is difficult to 
remove bubbles from 384-well plates. 

6.	 Optional: Add 0.5 µl PCR control assay template into the appropriate well (total volume 
will be 10.5 µl — additional volume will not affect the qPCR reaction).

7.	 Seal the plate with an optical seal. Optional: Briefly centrifuge to remove bubbles (4,000 rpm 
for 4 min at room temperature). 

8.	 Load the PCR plate into the real-time PCR instrument.

Individual Assays
Protocols for primer assays, probe assays, and control assays follow. PrimePCR individual 
assays come ready to use as a 20x stock solution.

SYBR® Green Assay

1.	 Thaw SsoAdvanced Universal SYBR® Green Supermix, PrimePCR SYBR® Green Assay, 
cDNA samples, and positive PCR control (if used) to room temperature. Mix thoroughly 
by inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of 
tubes, and then store on ice and protected from light.

2.	 Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions by 
adding all required components. PrimePCR SYBR® Green Assays are provided as a 
20x stock solution. Scale up proportionally for technical replicates. CFX Software has an 
easy-to-use master mix calculator that provides easy scale-up calculations for  
your experiment.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Universal SYBR®  
Green Supermix

10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

3.	 Transfer the appropriate volume of the PCR reaction mix into each tube or well: 20 µl for 
a 96-well plate, or 10 µl for a 384-well plate. 

4.	 Optional: Set up control reactions to determine RNA quality, PCR and RT reaction 
performance, and gDNA contamination (see detailed instructions below).

5.	 Seal the plate with an optical seal. Optional: Briefly centrifuge to remove bubbles (4,000 rpm 
for 2 min at room temperature).

6.	 Load the PCR plate (or tubes) into the real-time PCR instrument.
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Probe Assay

1. Thaw SsoAdvanced Universal Probes Supermix, PrimePCR Probe Assay, cDNA
samples, and positive PCR control (if used) to room temperature. Mix thoroughly by
inversion or a 15 sec vortex, centrifuge briefly to collect solutions at the bottoms of
tubes, and then store on ice and protected from light.

2. Prepare (on ice or at room temperature) enough reaction mix for all qPCR reactions
by adding all required components. PrimePCR Probe Assays are provided as a 20x
stock solution. Scale up PCR reaction mix proportionally for technical replicates.
CFX Software has an easy-to-use master mix calculator that provides easy scale-up
calculations for your experiment.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Universal Probes Supermix 10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

*	Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

3. Transfer the appropriate volume of the PCR reaction mix into each tube or well: 20 µl for
a 96-well plate, or 10 µl for a 384-well plate.

4. Optional: Set up control reactions to determine RNA quality, PCR and RT reaction
performance, and gDNA contamination (see detailed instructions below).

5. Seal the plate with an optical seal. Optional: Briefly centrifuge to remove bubbles (4,000 rpm
for 2 min at room temperature).

6. Load the PCR plate (or tubes) into the real-time PCR instrument.

Positive PCR Control Assay (PCR)

1. For each cDNA sample, prepare a positive PCR control reaction mix (template and assay
included in the same tube).

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR Positive PCR Control Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.
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2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the qPCR reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

Reverse Transcription Control Assay (RT)

1.	 Resuspend lyophilized RT control assay template in 200 µl nuclease-free TE buffer (pH 7.5) 
or the same reagent used to dilute RNA samples. Keep template on ice. It will degrade 
similar to RNA samples if exposed to multiple freeze-thaw cycles, ambient temperatures, 
or RNases.

2.	 For each RNA sample, include 1 µl of the control RNA template in each 20 µl cDNA 
synthesis reaction, and proceed with the reverse transcription reaction. 

3.	 Once cDNA is synthesized and diluted to working stock, prepare a reverse transcription 
control reaction mix.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR RT Control Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

cDNA Sample with RT Control Template 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample 
to avoid excessive carryover of PCR inhibitors.

4.	 Follow the remainder of the PrimePCR cycling protocol.

5.	 Assess performance of the RT reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

DNA Contamination Control Assay (gDNA)

1.	 For each cDNA sample, prepare a DNA contamination control reaction mix.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR gDNA Control Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample to 
avoid excessive carryover of PCR inhibitors.

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess gDNA contamination (see Chapter 3, Interpretation of Experimental Control Assays).
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RNA Quality Assay (RQ1 and RQ2)

1.	 For each cDNA sample, prepare RQ1 and RQ2 RNA quality assay reaction mixes.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR RQ1 Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR RQ2 Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

cDNA Sample 1–4 μl* 0.5–2 μl* 100 ng–100 fg*

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

* Calculated during Step 2, cDNA Synthesis and Optional Preamplification. Avoid adding >20% reaction volume of cDNA sample to 
avoid excessive carryover of PCR inhibitors.

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the qPCR reaction (see Chapter 3, Interpretation of Experimental 
Control Assays).

PreAmp Control Assay (PAQ1 and PAQ2)

The preamplification control assay is compatible only with preamplification protocols 
using the iScript Explore One-Step RT and PreAmp Kit. This control is not compatible with 
SsoAdvanced PreAmp Supermix protocols.

1.	 For each cDNA sample preamplified using the iScript Explore Kit, prepare PAQ1 and 
PAQ2 preamplification control assay reaction mixes.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR PAQ1 Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

Preamplified cDNA Sample 2 μl 1 μl —

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —
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Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR PAQ2 Assay 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

Preamplified cDNA Sample 2 μl 1 μl —

Nuclease-Free Water Variable Variable —

Total volume 20 μl 10 μl —

2.	 Follow the remainder of the PrimePCR cycling protocol.

3.	 Assess performance of the PreAmp Control Assay reaction (see Chapter 3, Interpretation 
of Experimental Control Assays).

Step 4: Cycle in Real-Time PCR Instrument
Load the PCR tubes or plate on the real-time PCR instrument and program the thermal 
cycling protocol according to the following table. Start the real-time PCR run. 

Step Temperature Time No. of Cycles

Activation 95°C 2 min* 1

Denaturation 95°C 5 sec 40

Annealing/extension 60°C 30 sec 40

Melt curve** 65–95°C  
(0.5°C increments)

5 sec/step 1

* 	 Activation can be reduced to 30 sec. Do not use a 10-min activation time with Bio-Rad supermixes.
** Melt curve step is for SYBR® Green analysis only.

Step 5: Analyze Gene Expression Data
Process your data and evaluate results using CFX Manager, CFX Maestro, or other analysis 
software. See Chapter 5, CFX Software Quick Guide, or consult your instrument and software 
manuals for detailed instructions. If PrimePCR Control Assays were used, refer to Chapter 3 to 
interpret sample quality and reaction performance.

Preamplification is a powerful tool for target enrichment prior to qPCR. However, 
preamplification also lowers the limit for what is considered a reliable amplification event. 
When performing preamplification, consider the number of preamplification cycles run when 
determining the Cq cutoff for reliable data. For example, with 12 cycles of preamplification, 
the qPCR Cq values >28 cycles should be examined carefully to ensure the robustness of 
the data. When using SYBR Green Assays, confirm that the postamplification melt curves 
produce a single melt peak corresponding to the intended product. Replicate experiments 
of late amplification events may be required to validate the expression results. When 
using preamplification protocols, these same considerations should be applied to the 
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PrimePCR gDNA Control Assay, which will also appear at an earlier Cq value than without 
preamplification.

The table below displays theoretical Cq values for 1 ng of sample, run for varying 
preamplification cycles and diluted 1:10 before going into recommended qPCR conditions 
(2 μl of sample per 20 μl reaction). Use this table as a guide to aid in interpreting reliable 
amplification events. 

Cycles of Preamplification
Number of Cycles Earlier  
That Target Is Detected 

Cq Limit of Single  
Copy Detection

10 2.034 33

12 4.034 31

14 6.034 29

Gene Expression Protocols



22  |  PrimePCR Assays, Arrays, and Controls for Real-Time PCR



PrimePCR Assays, Arrays, and Controls for Real-Time PCR  |  23

3	 Interpretation of 
Experimental Control Assays

PrimePCR Experimental Control Assays are designed to help assess the quality of your 
sample(s) and how this may affect the performance of the reverse transcription and qPCR 
reactions. They work alongside any assay from any source. This chapter explains how 
to interpret control assays. For control assay reaction setup, refer to the format (plate or 
individual assay) in Chapter 2, Gene Expression Protocols.

CFX Maestro Software enables you to easily determine RNA quality and troubleshoot 
experiments with the PrimePCR Controls Analysis tool. This tool can be found in the Gene 
Study module.

The PrimePCR Controls Analysis tool displays the results of the tested samples in a table. 

■■ The Summary tab displays a summary of all tested samples. Samples that passed all 
of the control assays appear in green. Samples that failed one or more of the control 
assays appear in yellow

■■ The PCR tab displays the results of the positive PCR control assay. This assay detects 
inhibition or experimental problems that affect gene expression 

■■ The RT tab displays the results of the reverse transcription control assay. This assay 
qualitatively evaluates RT performance and identifies samples where RT performance is 
likely to compromise gene expression analysis

■■ The gDNA tab displays the results of the DNA contamination control assay. This assay 
determines whether gDNA is present in a sample at a level that might affect qPCR results 

■■ The RQ tab displays the results of the RNA quality assays (RQ1 and RQ2). These assays 
qualitatively assess whether RNA integrity might adversely affect gene expression

For detailed instructions, please refer to your CFX Maestro Software manual. 
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Compatibility of PrimePCR Control Assays with Preamplification
The addition of the preamplification step alters the compatibility of some PrimePCR Control 
Assays. Refer to the table below to determine PrimePCR Control Assay compatibility for the 
two preamplification reagent workflows when using different PrimePCR PreAmp Assays. 

Preamplification 
Reagent

PrimePCR  
PreAmp Assays

PCR 
Control

RT  
Control

RQ1 and 
RQ2

gDNA 
Control

PAQ1 and 
PAQ2

iScript Explore 
One-Step RT and 
PreAmp Kit

Preblended PrimePCR 
lncRNA PreAmp 
Assay Pools

Yes Yes Yes Yes Yes

Individual PrimePCR 
PreAmp Assays

Yes Yes No No Yes

SsoAdvanced 
PreAmp  
Supermix

Preblended PrimePCR 
lncRNA PreAmp 
Assay Pools

Yes No Yes Yes No

Individual PrimePCR 
PreAmp Assays

Yes No No No No

Positive PCR Control Assay (PCR)
Purpose: The positive PCR control assay (PCR) targets a synthetic DNA template to 
determine if samples contain inhibitors or other factors that may negatively affect your gene 
expression results. The sequence of the synthetic DNA template is not present in the human 
or mouse genome.

Designed to qualitatively assess:

■■ Performance of a qPCR reaction associated with a single sample

■■ Relative performance of the qPCR reactions associated with different samples

Format:

■■ Individual assay — 200 reactions (20x stock solution includes primers and DNA template)

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate, and 
the DNA template is provided in a separate tube

Interpretation:

■■ Single sample — Cq ≥ 30 indicates poor PCR performance; will likely compromise gene 
expression results

■■ Two or more samples — designate one of your samples as the control. To determine the 
ΔCq between the control sample and each remaining sample, use the following equation:

|(PCR Cq for control sample) – (PCR Cq for sample)| = ΔCq

ΔCq > 1 indicates samples differ in their impact on qPCR performance and may 
compromise gene expression results.
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Reverse Transcription Control Assay (RT)
Purpose: The reverse transcription control assay (RT) introduces a synthetic RNA template 
into the cDNA synthesis reaction to evaluate the RT performance. The sequence of the 
synthetic RNA template is not present in the human or mouse transcriptome.

Designed to qualitatively assess:

■■ Performance of a reverse transcription reaction associated with a single sample

■■ Relative performance of the reverse transcription reactions associated with different samples

Format:

■■ Individual assay — 200 reactions of 20x stock solution PrimePCR Reverse Transcription 
Control Primer Assay and 200 reactions lyophilized RNA template

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate, 
and the lyophilized RNA template is provided in a separate tube

Interpretation:

■■ Single sample — Cq ≥ 30 indicates poor reverse transcription reaction performance; will 
likely compromise gene expression results

■■ Two or more samples — designate one of your samples as the control. To determine 
the ΔCq between the control sample and each remaining sample, use the following 
equation:

|(RT Cq for control sample) – (RT Cq for sample)| = ΔCq

ΔCq > 1 indicates that samples differ in their impact on reverse transcriptase 
performance and may compromise gene expression results.

DNA Contamination Control Assay (gDNA)
Purpose: The DNA contamination control assay (gDNA) is a species-specific control assay 
that targets a nontranscribed region of the genome.

Designed to qualitatively assess:

■■ Whether genomic DNA (gDNA) is present in a sample at a level that may affect  
qPCR results

■■ Relative levels of gDNA contamination present in different samples to determine if  
qPCR results may be affected

Format:

■■ Individual assay — 200 reactions (20x stock solution)

■■ 96-well or 384-well plate — primers are lyophilized in designated well(s) on the plate

Interpretation of Experimental Control Assays
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Interpretation:

Without Sample Preamplification:

Single sample: 

■■ Cq ≥ 35: indicates below single copy detection; no gDNA present

■■ Cq < 35: indicates the sample is contaminated with gDNA and gene expression results 
may be affected. The relative contribution of gDNA contamination to a sample’s signal 
can be determined by comparing the Cq value for a given gene of interest (GOI) to the 
Cq value for the DNA contamination control assay using the following equation:

|(GOI Cq) – (gDNA Cq)| = ΔCq

∆Cq Percentage Contribution

1 50

2 25

3 12.5

4 6.25

5 3.13

6 1.56

7 0.78

Two or more samples: Designate a sample as the control. To determine the ΔCq between 
the control sample and each remaining sample, use the following equation:

|(gDNA Cq for control sample) – (gDNA Cq for sample)| = ΔCq

■■ ΔCq < 1: samples have similar levels of gDNA contamination; gDNA contamination will 
likely have little to no effect on results

■■ ΔCq ≥ 1: samples have different levels of gDNA contamination; gDNA contamination  
may affect gene expression results

With Sample Preamplification:

For preamplification reactions, the gDNA control is supported for long noncoding RNA 
(lncRNA) expression experiments only when preblended PrimePCR lncRNA PreAmp Assay 
Pools and PrimePCR lncRNA Predesigned Arrays are all used together. The gDNA control 
is not supported for any other preamplification reactions. When preblended PrimePCR 
lncRNA PreAmp Assay Pools and PrimePCR lncRNA Predesigned Arrays are used together, 
contaminating gDNA is amplified during the preamplification step and detected during 
qPCR. During interpretation, the number of rounds of preamplification must be considered 
to determine the appropriate cutoff for this control. 

Note: Important considerations for gDNA control if preamplification was performed.  
CFX Maestro Software was designed to assess gDNA contamination in non-preamplified 
samples and has an assay failure cutoff of a Cq <35. However, when preamplification is used, 
the Cq cutoff must be lowered. When preamplification is conducted, use the pass/fail criteria 
shown in the table below to determine whether significant gDNA is present in your samples.
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Number of Preamplification Cycles Preamplified Sample Pass, Cq Preamplified Sample Fail, Cq

10 ≥33 <33

12 ≥31 <31

14 ≥29 <29

RNA Quality Assay (RQ1 and RQ2)
Purpose: The RNA quality assay is a pair of assays (RQ1 and RQ2) that target the same 
transcript at different locations with different amplicon sizes. The RQ1 and RQ2 assays must 
be used as a pair for each cDNA sample. Differences in Cq values can indicate whether 
RNA degradation may be negatively impacting gene expression results.

Designed to qualitatively assess:

■■ Whether RNA integrity may adversely affect PCR results of a single sample

■■ Relative RNA integrity between samples to determine if qPCR results may be affected

Format:

■■ Individual assay — 200 reactions (20x stock solution) of RQ1 RNA quality assay and  
200 reactions (20x stock solution) of RQ2 RNA quality assay

■■ 96-well or 384-well plate — RQ1 and RQ2 primers are lyophilized in designated well(s) 
on the plate

Interpretation:

■■ Single sample — to determine the ΔCq between the RQ1 and RQ2 assays, use the 
following equation:

|(RQ2 Cq) – (RQ1 Cq)| = ΔCq

ΔCq ≤ 3.0: RNA degradation is minimal and will likely have little to no effect on gene 
expression results

ΔCq > 3.0: RNA integrity may compromise gene expression results

■■ Two or more samples — designate one of your samples as your control sample. To 
determine the ΔΔCq between the control sample and each remaining sample, use the 
following equation:

[ |(RQ2 Cq for designated control sample) – (RQ1 for designated control sample Cq)| ] –  
[ |(RQ2 Cq for sample) – (RQ1 for sample Cq)| ] = ΔΔCq

ΔΔCq = 0 to 1.0: samples are similar in quality; will likely have little to no effect on gene 
expression results

ΔΔCq = 1.0 to 2.0: RNA integrity differs; will likely have slight to moderate effects on 
gene expression results

ΔΔCq > 2.0: RNA integrity differs; will likely have significant effects on gene expression 
results

Interpretation of Experimental Control Assays
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PreAmp Control Assay (PAQ1 and PAQ2)
Purpose: The purpose of the PreAmp Control Assay (PAQ1 and PAQ2) is to validate 
performance of the one-step preamplification reaction. This control assay is compatible only 
when the iScript Explore Kit is used with PrimePCR lncRNA Predesigned Arrays or custom 
plates with PAQ1 and PAQ2 controls added to the plate. This control is not compatible with 
the two-step SsoAdvanced PreAmp Supermix protocols. 

When using the iScript Explore Kit, the PAQ1 assay and not the PAQ2 assay is amplified 
during the preamplification reaction. During the qPCR reaction, both PAQ1 and PAQ2 are 
amplified. The ΔCq between the preamplified PAQ1 and the non-preamplified PAQ2 should 
approximately equal the number of preamplification cycles run. 

Designed to qualitatively assess:

■■ Whether the desired number of preamplification cycles is equivalent to the actual 
observed preamplification of the control

Format:

■■ PAQ1 primers are included in iScript Explore Kit components. PAQ1 and PAQ2 assays 
are lyophilized in designated wells on all PrimePCR lncRNA Predesigned Arrays and, if 
desired, PAQ1 and PAQ2 can be added to all custom-designed plates

Interpretation: 

■■ For each cDNA sample 
(PAQ2 Cq – PAQ1 Cq) = ΔCq

Performance of preamplification is verified if the ΔCq is within 1 Cq value of the number of 
preamplification cycles performed. For example, if 14 preamplification cycles were used, 
the preamplification reaction was efficient if the Cq difference between PAQ1 and PAQ2 is 
between 13 and 15.

Interpretation of Experimental Control Assays
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4	 DNA Templates

PrimePCR DNA Templates are single-stranded synthetic DNA templates that are 
complementary to corresponding gene-specific PrimePCR Assays. Each template is linked 
to the corresponding assay with a Unique Assay ID. Templates for use with SYBR® Green 
Assays are 60 base pairs in length, and those for use with probe assays are 90 base pairs in 
length. They are designed to give a positive real-time PCR result when used with the correct 
PrimePCR Assay and can also be used to generate a standard curve.

Format: Individual template — 200 reactions (20x stock solution) of assay-specific template 
(20 x 106 copies/µl)

Procedure:

1.	 For use as a qPCR control, prepare the reaction mix.

Volume per Reaction

Component 96-Well 384-Well Final Concentration

20x PrimePCR Assay for gene of interest 1 μl 0.5 μl 1x

2x SsoAdvanced Supermix 10 μl 5 μl 1x

20x PrimePCR cDNA Template for gene of interest 1 μl 0.5 μl 20 x 106 copies/μl

Nuclease-Free Water 8 μl 4 μl —

Total volume 20 μl 10 μl —

2.	 Follow the PrimePCR cycling protocol and evaluate results to determine assay 
performance.

Interpretation: When used as a qPCR control

■■ Cq < 30: assay performance is not affected

■■ Cq > 30: poor PCR performance; will likely compromise results

Standard Curve:

Perform a standard curve using a seven-point, tenfold serial dilution series from 20 million 
copies to 20 copies. Prepare serial dilutions of a stock solution of 10 ng/ml tRNA in TE buffer 
(pH 8.0).
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5	 CFX Software Quick Guide

For detailed instructions, please refer to your CFX instrument manual or CFX Software manual.

PrimePCR Run Setup
1.	 To begin a PrimePCR protocol, select the PrimePCR button from the Startup Wizard 

and go to File > New > PrimePCR run, or drag and drop a PrimePCR run file* onto the 
main window of CFX Software.

2.	 Once a PrimePCR run has been selected, the Run Setup window opens in the Start Run 
tab. The PrimePCR default protocol and plate layout are loaded.

3.	 For SYBR® Green or FAM experiments, select the SYBR/FAM scan mode. For probe 
assays using other fluorophores (HEX and TEX 615) or for multiplex experiments, open 
the Plate tab and use the Edit Selected option to choose the specific fluorophores and 
select the All Channels scan mode. 

4.	 For SYBR® Green Assays, select Include Melt Step in the Protocol tab; deselect it for 
probe assays.

5.	 Once the plate and protocol are loaded, click Close Lid and Start Run.

Data Analysis for Gene Expression Experiments
1.	 Drag and drop the PrimePCR run file for a predesigned or custom plate before or after a 

protocol run in order to populate the assay names for data analysis. Alternatively, open a 
data file by selecting File > Open > Data file. If analyzing data from multiple plates, skip 
to Step 5 and set up a gene study.

2.	 The plate should contain sample and target information, as well as control information. 
Select reference targets in Experiment Settings.

3.	 Once the above requirements are met for normalized gene expression analysis, the 
Quantification and Quantification Analysis tabs of the Data Analysis window display a 
table of Cq values, averages, standard deviations, and normalized values.

* �PrimePCR run files for predesigned and custom plates can be downloaded from bio-rad.com/PrimePCR. Custom plates are saved 
under My PrimePCR once configured and purchased. Predesigned arrays have a Download Run File button on the Review Plate page.	

http://bio-rad.com/PrimePCR
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CFX Software Quick Guide

Note: Important data analysis considerations for preamplification reactions. 
Preamplification lowers the limit for what is considered a reliable amplification event. If 
preamplification was performed, consider the number of preamplification cycles run when 
determining the Cq cutoff. For example, if 12 rounds of preamplification were conducted, 
data points with Cq values >28 cycles should be examined carefully to ensure the 
robustness of the data. As part of data analysis, confirm that the postamplification melt 
curves produce a single melt peak corresponding to the intended product. Replicate 
experiments of late amplification events may be required to validate the expression results. 

4.	 Bar charts, clustergrams, scatter plots, volcano plots, and heat maps are available under 
the Gene Expression tab.

5.	 Create a gene study to compare gene expression data from one or more real-time PCR 
experiments using an inter-run calibrator to normalize between experiments. 

a.	 Go to File > New > Gene Study.

b.	 A Gene Study window opens. To add data files for the gene study, select File > Add 
Data File and choose the .pcrd data files you would like to analyze.

c.	 CFX Software automatically attempts an inter-run calibration (IRC) to normalize for 
variation between different plates. An inter-run calibrator must have the same sample 
and target between plates. If no such well exists on the PrimePCR Plate, consider 
designating a positive PCR control well as the IRC, and be sure that the sample and 
target are labeled the same (for example, edit sample name to IRC and target to 
Positive PCR). 

6.	 After gene expression, generate analysis reports by selecting Tools > Reports… or 
export the data to Microsoft Excel by selecting Export > Export All Datasheets  
to Excel.

Note: PrimePCR Analysis Software is available for real-time platforms not made by  
Bio-Rad. This enables easy PrimePCR Plate file population with data (Cq values) 
generated on any real-time PCR instrument. Visit bio-rad.com/PrimePCR to  
download the software and instruction manual. 

http://www.bio-rad.com/PrimePCR
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6	 Reference Gene Selection 
and Reference Gene Arrays

To ensure proper normalization of loaded RNA in a gene expression experiment, use a 
stable, validated reference gene(s). The reference gene(s) should maintain consistent 
expression across all samples in the project regardless of treatment, source, or extraction 
method. The number used and specific choice of reference genes are key factors in 
determining the magnitude of change in expression that can be detected. To detect large 
changes (greater than fourfold), a single reference gene may be sufficient. For smaller 
changes (less than fourfold), use multiple well–validated reference genes to prevent 
confounding effects produced by fluctuations in basal or uninduced expression in any single 
reference gene. In addition, validate reference genes for stability using this method:

1. Choose candidate reference genes.
Select a list of candidate reference genes using published references as guidance. Use 
at least five reference genes for evaluation. For your convenience, Bio-Rad offers human, 
mouse, and rat preplated reference gene arrays using our validated and optimized 
PrimePCR Assays. Each reference gene array contains 14 reference genes commonly 
used in gene expression studies. The 96-well plate can accommodate up to six unique 
samples (or three samples in duplicate or two samples in triplicate), while the 384-well plate 
can accommodate 24 unique samples (or twelve samples in duplicate, eight samples in 
triplicate).

2. Select representative samples across the groups.
Select samples to represent all the conditions to be used in the study (for example, 
treatments, tissues, time courses), ensuring that all variables within the sample groups  
are evaluated.
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Reference Gene Selection and Reference Gene Arrays

3. Isolate the RNA.
Isolate the RNA from the samples and treat with DNase using the same protocol for all 
samples. Quantify and normalize the RNA to the same concentration.

4. Perform reverse transcription to cDNA.
Perform a reverse transcription reaction for each sample using the same kit, column, and 
concentration. Dilute the cDNA, as needed, treating each sample the same to ensure there 
are no differences from sample to sample in terms of volume and concentration from the 
initial input RNA.

5. Analyze expression using real-time PCR.
Perform a real-time PCR experiment using the samples and the reference gene array, or 
your selected reference gene assays.

6. Evaluate stability.
CFX Maestro Software enables you to easily select the appropriate reference gene and 
analyze its stability with the Reference Gene Selection tool. This tool can be found in the 
Gene Study module.

The Reference Gene Selection tool identifies the tested reference genes and categorizes 
them as Ideal, Acceptable, or Unstable based on their stability. 

■■ Ideal reference genes are stable and represent minimal variations across the tested 
samples 

■■ Acceptable reference genes are not ideally stable and represent moderate variation 
across tested samples. Use these reference genes in analysis if no Ideal reference genes 
are present 

■■ Unstable reference genes represent excessive variation across tested samples. We 
recommend that these genes be excluded from analyses

Statistical validation of reference gene stability is detailed in a study by Vandesompele  
et al. (2002) using an iterative test of pairwise variation. CFX Software includes this method 
as an automated dialog. To calculate the M value for each reference gene tested, open 
the data file in the Gene Expression tab and select Target Stability. The M values will be 
presented in tabular format in a dialog box. The lowest M value corresponds to the most 
stable expression in the tested samples, and recommended cutoff values for M are <0.5 (for 
homogenous sample sets) and <1 (for heterogenous sample sets). Reference gene stability 
can also be calculated using Biogazelle’s geNorm or qbase+ software. Alternatively, use 
coefficient of variation (CV) or analysis of variance (ANOVA) methods to evaluate stability. 

Reference
Vandesompele J et al. (2002). Accurate normalization of real-time quantitative RT-PCR data by geometric averaging 
of multiple internal control genes. Genome Biol 3, RESEARCH0034.
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7	 MIQE Compliance

The minimum information for publication of quantitative real-time PCR experiments 
(MIQE) guidelines allow for greater transparency in qPCR data across laboratories. These 
guidelines allow scientists to investigate the quality of results presented and the ability to 
repeat experiments precisely. Bio-Rad’s PrimePCR Assays make MIQE compliance easy. 
Each PrimePCR Assay provides a Unique Assay ID, which can be easily tracked and 
reported in publications. These IDs are provided on the website when ordering and on the 
specifications sheets accompanying the product when shipping. Additionally, each wet-lab 
validated PrimePCR Assay has a thorough validation report that includes which transcripts 
for a given gene are targeted, and a context sequence where the amplicon can be found. 
For more information on how PrimePCR Assays meet MIQE guidelines, refer to bulletin 
6262 (found under the Documents tab at bio-rad.com/PrimePCR) or review the original 
publication (Bustin et al. 2009). 

Reference
Bustin SA et al. (2009). The MIQE guidelines: Minimum information for publication of quantitative real-time PCR 
experiments. Clin Chem 55, 611–622.

http://www.bio-rad.com/primepcr
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8	 Frequently Asked Questions

How did Bio-Rad wet-lab validate PrimePCR Assays?
Every mRNA primer pair for human, mouse, and rat was experimentally tested by generating 
an amplification plot using universal RNA, conducting a melt curve analysis, and calculating 
the efficiency and dynamic range from a seven-point standard curve using 20–20,000,000 
copies of synthetic template. Specificity was determined by next-generation sequencing of 
the amplicon.

Where can I find validation reports?
At bio-rad.com/PrimePCR, each assay has a PDF with validation data, including assay 
information, transcripts detected, validation graphs and values, and a key for interpreting data.

Can I multiplex PrimePCR Probe Assays?
The fluorophores chosen for PrimePCR Probe Assays enable multiplex experiments. See 
Multiplex Assay Considerations in Chapter 1. 

Do I need to preamplify my cDNA?	
Preamplification is an optional step in the PrimePCR protocol. Performing preamplification 
will allow the user to perform more real-time PCR reactions from limited amounts of sample 
(10 pg–100 ng cDNA). Additionally, preamplification is recommended when studying genes 
expressed at low levels, such as most lncRNA. 

Will Bio-Rad provide primer sequence information?	
No. The MIQE context sequence of the amplicon is provided in the validation information. 
Exact sequences are not provided.

Can PrimePCR products be ordered using PunchOut?
Yes.

What does guaranteed performance mean?
Assay should deliver high quality data when used with Bio-Rad amplification reagents and 
samples of sufficient quality.

http://www.bio-rad.com/primepcr
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9	 Troubleshooting

Troubleshooting guide.

Symptom Cause Treatment

Positive gDNA experimental control gDNA in sample Perform DNase digestion during RNA purification step

Positive NTC (no template control) DNA contamination in workflow Identify and eliminate source of contamination  
(plastics, reagents, workspace, etc.) 

Unexpectedly high Cq values and a  
positive PCR experimental control value

Possible PCR inhibitors in reaction Identify and eliminate inhibitor (see list of common 
inhibitors below) by purifying samples using a post-
isolation cleanup kit

Wells along edge of PCR plate are 
varying between technical repeats

Evaporation of PCR reactions	 Seal plate better before placing in thermal cycler; use a 
heat sealer for best results

Variability in reference gene Cq values 	
	

Expression of reference gene is not 
stable in RNA sample

Analyze expression levels of multiple reference genes 
from all sample/condition combinations and choose a 
stably expressed target(s)

RNA quality control assay is outside 
acceptable range		

RNA is degraded Prepare and purify a new RNA sample, keeping it at 
–80°C until use 
Limit freeze-thaw cycles 
Eliminate RNases from workspace/reagents

Spikes in early cycles of amplification 
traces

Bubbles present in wells and  
popping during cycling	

Take care when adding samples to plates, especially 
384-well plates. Position the pipet tips almost to the 
bottom and dispense sample into wells, being careful 
not to go to the second stop, which will expel a small 
air bubble into the sample

Standard curve using synthetic  
template does not appear to be linear, 
or efficiency is not close to what is  
described in the validation data	

Loss of synthetic template during 
serial dilutions	

Use 10 ng/µl of tRNA in TE buffer (pH 8.0) when  
diluting template
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Troubleshooting

Common PCR inhibitors.

Source of Contamination

Sample Isolation Method

Melanin Ethanol >1% v/v

Polysaccharides Proteinase K

Hemoglobin DMSO >5%

Chlorophyll EDTA >50 mM

Polyphenolics SDS >0.01% w/v

Heparin Sodium acetate >5 mM

Humic acid Mercaptoethanol

Hematin Guanidinium

Phenol >0.2% v/v

DTT >1 mM
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10	 Ordering Information

Visit bio-rad.com/PrimePCR to order PrimePCR products. All products must be ordered 
and quoted online to ensure correct assays of interest and configuration of arrays. To check 
for availability of genes and determine the best array based on your targets of interest, visit 
bio-rad.com/PrimePCR_Lookup and use our easy lookup tool.

Related Products
Visit bio-rad.com/amplification to learn more about Bio-Rad’s complete solutions 
for real-time PCR..

http://www.bio-rad.com/PrimePCR
http://www.bio-rad.com/primepcr_lookup
http://www.bio-rad.com/amplification
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